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1 検出器データから画像を作成する

1.1 イメージ・ファイルからの画像合成

測定された検出器画像 (img i.txt)を手際よく ImageJ2で観察する方法について述べる．なお，マクロ

プログラムなどは ImageJの種類の一つである Fiji3を利用して確認した4．
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図 1: CdTe検出器の測定データ img i.txtの構成

プログラム ’cdte.f90’ は，img i.txt からデータを読み出し，ImageJ で読めるテキスト画像ファイル
Image000i.txtに変換する．CdTe検出器で測定されたデータファイルは，img i.txtのテキストファイルで
ある．ファイルのフォーマットと内容を図 1に示す．このテキスト形式データをそのまま逐次読み取り，
その後再構成して，ImageJのテキストイメージに再構成して，出力ファイル Image000i.txtを作成する．
そのまま読み込んで行くと，1行目は FileName，2行目は閾値電圧 (mV)が記録されており，14行目
から読出した各画素の位置 (x, y)とカウントが記録されている (図 1左)．データは 100行単位で CdTe
センサーのセグメント A, B, C, Dに対応する．
ファイル img i.txtから読み出したデータ群 A, B, C, Dを CdTeセンサーのセグメントの配置に従って
イメージを再構成しなければならない．そのセグメント A∼Dの配置は，図 2のように各セグメントの
向きと位置が異なっている．図の配置に合うようにデータ群 A, B, C, Dを配置するプログラムを作成し

1作成したプログラムはすべて付録に収録している．また，変更されるたびに最新のツールは以下の URL からダウンロードで
きる．
http://kikai.ed.niigata-u.ac.jp/CdTe/

2ImageJ はアメリカ国立衛生研究所の Wayne Rasband により開発が始められた．Java の仮想マシン上で動作し、プラグインや
マクロによる拡張性が高い．次のサイトからダウンロードできる．https://imagej.nih.gov/ij/

3J. Schindelin, I. Arganda-Carreras, and E. Frise, et al. (2012), ”Fiji: an open-source platform for biological-image analysis”, Nature
methods 9(7): 676-682, PMID: 22743772.

4Mac 用の ImageJ は，Java 6 で作成されており，High Sierra では動作しないので，Fiji を利用すること．
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図 2: CdTe半導体の実際の配置

た．実際の検出された画像は，191行 201列のデータとなる．また，95行目と 100列目はセンサーの貼
り合わせのために画素が抜けている．この補正については，文献5を参考にして補正計算をした．

1.2 画像ファイルの貼り合わせ

前節で作成された Image000i.txtは，ImageJで見ることができる．

読み込み File → Import → Text image

画質調整 ノイズや画素不良により，見たい画像が見れないので，以下の画質調整をすること．

Image → Adjust → Brightness/Contrast → Set

表示形式 白黒から見やすい画像に変換する．以下は，fireにより表示した例
Image → Lookup tables → fire

これでは 1枚ずつ読み込むので，以下では，CdTe検出器をステージで動かして貼り合わせるために，
ImageJのマクロ’Composition.ijm’を作成した．その一例として 3× 3の CdTe検出画像を図 3を以下に
示す．

マクロの定義 ImageJの Plugins → Macros → Installを起動して，マクロプログラム”Composition.ijm”を
読み込む．

マクロの実行 Plugins → Macrosの下側→ Compose 3× 3を選択

2 エネルギー較正用ツール

エネルギー較正の結果を分析するためのツールを開発した”calibration.f90”を使用することで，次のよ
うな分析用データファイルが表示され，一連の処理を一括して行うことができる．また，表示には Fiji
(ImageJ)を利用する．

img 1.txt ∼ img 160.txt 閾値電圧を −200 ∼ −41まで 1 mVピッチで変化させた時の測定結果．

c map 0001.txt ∼ c map 0100.txt 閾値電圧−200 ∼ −41に対応する各ピクセルのカウント．1ファイル
に 380ピクセルずつ記録されている．(gnuplot用 3次元データ)

d map 0001.txt ∼ d map 0100.txt 閾値電圧−200 ∼ −41に対応する各ピクセルの差分．(gnuplot用 3次
元データ)

stack 0001.txt ∼ stack 0100.txt
5豊川秀訓，Spring-8における計数型 1次元, 2次元検出器の開発とその応用，Ｘ線分析の進歩第 42集，pp .95-110 (2011)，ア

グネ技術センター
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図 3: 3× 3の貼り合わせ画像例

380個のピクセルの閾値電圧とカウントのイメージ (stck i.txt)の全ファイル 100個を重ね合わせたス
タック像を表示するために，ImageJのマクロプログラム”Stack100.ijm”を用意した．

stack i.txtから動画の作成

1. フォルダ stackを作り，閾値電圧のイメージ stack 1.txt ∼ stack 100.txtを stackに移動
フォルダー内のファイル数を読み取り，ファイルの読み込み回数を計算しているので，フォルダ

stackには stack i.txt以外を入れてはならない．
2. ImageJの Plugins → Macros → Install を起動して，マクロプログラム”Stack100.ijm”を読み込む．

(Macrosを見ると Stack(100)と Stack-d(100)ができている)

3. Plugins → Macros → Stack(100)を選択．フォルダ stackを選択すると，100個の stack i.txtファイ
ルが読み込まれ，すべてが重ね合わされる (図 4 (a))．

4. スタック像の 3次元表示は，Analyze → 3D surface plotを選択する．

5. スタック像のピクセルのカウントの変化を見るには，ラインツールを選択してAnalyze → Plot profile
を選択する．

6. スタック像を動画として保存するに，Save as → AVIを選択する．

stack-d i.txtから stack(重ね合わせ)と動画の作成

1. フォルダ stack-dを作り，閾値電圧微分 stack-d 1.txt ∼ stack-d 100.txtを stack-dに移動
フォルダー内のファイル数を読み取り，読み込みファイルの回数を計算しているので，フォルダ

stack-dには stack-d i.txt以外を入れてはならない．
2. ImageJの Plugins → Macros → Install を起動して，マクロプログラム”Stack100.ijm”を読み込む．

(Macrosを見ると Stack(100)と Stack-d(100)ができている)

3. Plugins → Macros → Stack-d(100)を選択．フォルダ stackを選択すると，100個の stack-d i.txtファ
イルが読み込まれ，すべてが重ね合わされる (図 4 (b))．

4. スタック像の 3次元表示は，Analyze → 3D surface plotを選択する．

5. スタック像のピクセルのカウントの変化を見るには，ラインツールを選択してAnalyze → Plot profile
を選択する．

6. スタック像を動画で保存 (Save as → AVIを選択)
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(a)各ピクセルのカウント (b)閾値電圧による前進差分像

図 4: エネルギー較正用ツールによる処理．横軸が閾値電圧，縦軸が各ピクセルになる．

3 エネルギー較正

利用する蛍光Ｘ線は, W, Sn, Pb, Moの 4種類の金属箔であり，その特性Ｘ線エネルギーを表 1に示す．

表 1: 特性Ｘ線

Atom Pb W Sn Mo

Kα (keV) 74.25 58.87 25.20 17.44
Kβ (keV) 84.94 67.24 28.49 19.61
K absorption edge (keV) 88.00 71.31 29.19 20.00

W, Sn, Pb, Moの 4種類の金属泊に白色Ｘ線を照射して，その蛍光Ｘ線を CdTe検出器で測定した．そ
れらの結果を図 5 (a)∼(d)に示す．各金属箔に対して，ピクセルごとのばらつきを見るために，No. 3000
と No. 30000の 2つのピクセルについて測定結果を示している．
各図には，閾値電圧に伴うカウント数の変化を示す．図中のカウントは，ノイズ除去の目的で 3点単
純移動平均の処理を施している．また，差分については，前進差分ではノイズもピークとして現れ，中

間差分 (xi+1−xi−1

2∆x )が，ノイズがなくピークが検出しやすかった．
図 (a), (b)の PbとWの結果では，ターゲット箔以外の特性Ｘ線も拾っていることがうかがえる．エネ
ルギー較正をする場合には，ターゲット以外の蛍光Ｘ線を拾わないように工夫することが大切である．

図 (c), (d)の SnおよびMoの結果を見ると，明瞭な Sn, Moの蛍光Ｘ線を検出できなかった．検出器
の閾値電圧が −60 mV付近で急激に増加した後，カウントが途絶えてしまう挙動が見られる．また，そ
の付近に Sn, Moの蛍光Ｘ線のエネルギーがあるために，エネルギー較正に難がある．いずれにしても，
おおよそ 30 keV以下のＸ線エネルギーについては，測定対象としてふさわしいかを再検討する必要が
ある．Ba-KαのＸ線エネルギーは 32.07 keVであり，Sn, Moよりもよい可能性がある．
図 6は，図 5の結果に基づいて蛍光Ｘ線のエネルギーと閾値電圧の関係を表示している．ピクセル

No. 3000と No. 30000では結果が異なることは，ピクセル依存性に加え，蛍光Ｘ線の照射の分布が一様
でないことが影響している．また，Sn, Moの結果が不明瞭なことから，PbとWを利用して CdTe検出
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図 5: 閾値電圧の変化に伴う各泊についての計数および差分 (No. 3000 and No. 30000ピクセルの例)
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図 6: 閾値電圧の較正結果 (No. 3000 and No. 30000ピクセルの例)

器のエネルギー較正をする方がよいかもしれない．

エネルギー較正の方針

1. 閾値電圧 vs計数においては，3点単純移動平均を用いる．

2. 差分は中間差分を利用する．

3. 差分の値はピクセルに入るフォトンの量に左右されるので，差分の値をカウント数で割って規格
化する．この処理は，低エネルギー領域のノイズを減少する効果もある．

4. Kβ のピークは
1

I

d I

dmV
≈ 0.3，Kαのピークは

1

I

d I

dmV
≈ 0.2で判別することも可能か．

5. 上記の判定に適合せず，カウントが検出されないピクセル，カウントがあっても計数値が異常な
ピクセルについては，別途考える．

以上の方針に工夫を加えることで，図 7のように明瞭に Kαおよび Kβ のピークを表示できるよう

になった．この図を図 4 (b)と比較すると，改良による効果がわかる．ピーク検出ができるようになっ
たことから，以下の方針により，Kα および Kβ のピークを検出し，ファイルに出力するプログラム

calibration.f90を作成した．

1. stack-d (100)の重ね合わせ像を見て，KαおよびKβ のピーク範囲の電圧値 v1,v2を入力する

2. 指定範囲内で差分値の符号が正から負に変化した位置をピークとして検出する．

3. 差分像のピーク値の大きい 2つのピクセル位置 (閾値電圧)，ピークカウントを記録する．

4. 該当のないピクセルについては，ピクセル位置=0，電圧値 = −200を入力する．

測定結果は，ファイル’peak.dat’として出力される．
peak.datを利用して CdTe検出器のエネルギー構成の統計を得るために，’evaluate.f90’を作成した．

evaluate.f90は，peak.datを読み込み，38000ピクセルの Kαおよび Kβ のピーク値からヒストグラム，

平均値および標準偏差を計算する．さらに，有効ピクセルと欠陥ピクセルの計数する．Pb箔およびW
箔の蛍光Ｘ線を測定した結果を図 8に示す．
図 8からわかるように，各検出器によるずれがあり，ヒストグラムには広がりが現れている．高エネ
ルギー側 (低電圧側)にヒストグラムの裾が広がる傾向にある．各図中には統計情報から得られた平均値
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(a) Pb箔 　 (b) W箔

図 7: 改良された差分像 (KαおよびKβ のピークが明瞭に見える)
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図 8: KαおよびKβ の閾値電圧の分布

(破線)および標準偏差が記されている．Pb箔とW箔に対する有効ピクセルと欠陥ピクセルの数を比較
すると，38000ピクセル中おおよそ 1000 ∼ 1500個のピクセルに欠陥がある．
図 8で得られた各箔の統計情報から CdTe検出器のエネルギー較正の式を導くために，図 9を作成し
た．Ｘ線エネルギー y [keV]と閾値電圧 V [mV]の関係がほぼ直線になることから，前述の手法で得られ

たピーク決定の方法の妥当性を確認することができた．

図 8の結果から，y [keV]と V [mV]の関係式として，

y [keV] = −0.7837329V [mV] − 24.48635 (1)

が得られる．また，目的とするＸ線エネルギー yに対応する閾値電圧 V を求める場合は，

V [mV] = −1.275945 y [keV] − 31.24323 (2)
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図 9: PbおよびWによるエネルギー較正

となる．これらの較正式を利用して，目的とするエネルギー値に対応する閾値電圧を決定することがで

きる．

4 CdTe検出器により測定した回折像の一括処理
CdTe検出器により測定すると，回折画像は大量に一連のファイル img i.txtとして保存される．これ
らの画像は，検出器の各位置にて閾値電圧 (−210 ∼ −60)を変えて，2 × 3の位置で測定し P1 の画像

(151枚)を取得する．その後，P2位置で 3× 5の測定した画像を同様に取得する．これらのファイルを

手作業で扱うことは効率的でない．そこで，以下のツールを開発し一気に P1，P2 の位置のデータを処

理して，tif画像のスタックとして保存できる．

作業ディレクトリ ディレクトリを決定し，そこに一括処理する img i.txt群を用意する．

閾値電圧フォルダー 閾値電圧ごとのフォルダーを用意する．以下のような batファイルを用意して実行
するとよい．データの読み書きに支障のないようにパーミッションを考えること．

mkdir -m 666 210
mkdir -m 666 209
mkdir -m 666 208
. . .

img i.txtの読込み・変換 img i.txtの読み込みと変換するために cdte2.f90を利用する．先頭のファイ
ルの番号 (p)．スタートする電圧 mV(符号なし, mV)，停止する電圧 mV(符号なし, mVe)，画像の
構成数 (nf)．このパラメータを入力すると 151間隔でファイルが移動して一巡する．nfの値を入
力すれば．6 = 2× 3，15 = 3× 5，9 = 3× 3にも適用できる．作成された Image000i.txtのセット
が閾値電圧ごとのフォルダーに書込まれる．

画像の合成 ImageJのマクロ all image.ijmをインストールしする．
Compose all 2x3　および　 Compose all 3x5は，閾値電圧ごとのフォルダーにある Image000i.txt
のセットを読込み，画像の合成し，各フォルダに tifで保存する．
Stack all(2x3)および Stack all(3x5)を利用して作成された tifイメージのスタック像を作る．
Diff all(2x3)および Diff all(3x5)は，中間差分像を作る．
Diff stack all(2x3)および Diff stack all(3x5)で差分像のスタックを作る．
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例 一括処理の流れの一例を以下にリストする．フォルダーやファイル名などは各自の条件に合うよう

にカスタマイズすること．

1. 作業 dirを作成

2. 処理予定 img.txtを移動，

3. 210 ∼ 60の dirの作成

4. cdte2.f90コンパイルして，./a.outで実行
データ入力

各 dirに Image000i.txtが作成される．

5. Fijiを起動

6. Pragin → Macros → Installから all image.ijmを読み込む．目的のマクロ処理を選択するとマクロ
を実行する．

(a) Compose all 3x5を選択して処理開始，各 dirに貼り合わせた像 P2 xxx.tifが作成されている．
(b) Stack all 3x5 P2の P2 xxx.tifによる stack像が作成される．
(c) Diff all(3x5)を選択し，中間差分像を作成する．
(d) Diff stack all(3x5)で中間差分像のスタックを作成する．

5 二重露光法のための一括処理

二重露光法はでは，検出器の閾値電圧を変化させながら 2つの位置 P1および P2において画面構成し

なければならない．その結果，大量のファイル処理を要する．その対策として，前述のプログラム要素

を組み合わせて，以下に示す二重露光法のための一括処理プログラムを作成した．

cdte2.f90 P1または P2の連続した imgファイル群を ImageJのテキストファイルに変換して閾値電圧の
各フォルダーごとセットする．

P1-P2.ijm 各フォルダー Image000i.txtから検出像を構成して P1- i .tifと，それらのスタック像も作成す
る．さらに，中間差分像 P1- i diff.tifと，それらのスタック像も作成する．

spot max.ijm 中間差分像 P1- i diff.tifの注目している領域の最大値を閾値電圧の関係を取り出す．

なお，各自の実験に対してプログラムをカスタマイズして利用できる．

5.1 手続き

以下の手続きに沿って，処理を進めるとよい．

1. フォルダ P1 (または P2)を作成する．

2. 関係する imgファイルを P1に移動．

3. md.batで P1の下にフォルダー (210 ∼ 60)を作成

4. フォルダー (210sim60)の everyoneに読み書きを許可のパーミッションを与える．

5. cdte2.f90を起動して Image 000 i .txtを作成．

6. ImageJを起動．

7. Plagin → Macros → Installでマクロプログラム P1-P2.ijmを読み込む．
8. Plagin → Macros → P1(2x3)を選択し，処理が開始される．

一括処理された結果，P1 (または P2)下の各フォルダー (209 ∼ 61)に以下のファイルが生成される．

P1- i .tif 検出画像．ただし，メジアンフィルタおよび移動平均処理済み．
P1- idiff.tif 検出画像の中間差分像

が作られる．さらに，P1 (または P2)フォルダーには，

P1 stack.tif 検出画像の閾値電圧に対する動画 (stack)

P1 diff stack.tif 検出画像の中間差分の閾値電圧に対する動画 (stack)
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6 ピクセルごとのエネルギー較正した画像

6.1 ピクセル単位のエネルギー較正のためのプログラム

閾値電圧 mVによる画像は，測定結果を概観するには役立つ．しかし，正確な CdTe検出器によるＸ
線エネルギーによる検出画像を得るためには，ピクセルごとにエネルギー較正をする必要がある．その

ためのツールを開発し，CdTe検出器によるツールの全体としてのシステムを完成した．全体の外観を示
すと図 10のようになる．

cdte2.f90

calibration.f90

CdTe_E.f90

E_image.f90

img_i.txt

peak.dat

Pb.dat

W.dat

Image000i.txt
folder(mV)

CdTe_E.dat
(i, ai, bi)

Image000i.txt

evaluate.f90 evaluate.dat

CdTe-system
E(keV) image

E(keV), n

cdte.f90
Image000i.txt

図 10: CdTe-systemの構成．これらの Image000i.txtの表示や処理のために，ImageJのマクロが用意され
ている．

図に示すように前節までのツールに加え，PbおよびWの蛍光Ｘ線によるエネルギー較正データ peak.dat
を利用して，各ピクセルごとのエネルギー較正直線

Ei
[keV] = ai V

[mV] + bi (3)

を求めるプログラム CdTe E.f90を作成した．プログラム CdTe E.f90は，その結果である 38,000ピクセ
ルの較正値 (i, ai, bi)をファイル CdTe E.datに出力する．
さらに，プログラム E image.f90は，要求されたＸ線エネルギーE(keV)と較正ファイル数 n(= 6, 15)

に従い，CdTe E.datに基づいて各ピクセルごとの対応する閾値電圧を計算して，閾値電圧ごとのフォル
ダーの image000i.txtから目的のピクセルのカウントを読み出しては，画素データを収集して，Ｘ線エネ
ルギー E(keV)に対応した新たな画像構成ファイル Image000i.txtのセットをワークディレクトリに生成
する．6

プログラム E image.f90 で較正するときに重要になるのが，検出器のデータフアイル img i.txt や
CdTe E.datのフォーマットは，一次元の array(ℓ)で格納されている．このデータフォーマットと Image000i
のイメージとの対応が複雑である．データの格納については，図 1と図 2ですでに説明しているが，ピ
クセルごとのエネルギー較正をするには，図 11にあるデータの格納と変換のしくみを理解しておくと
よい．

図 11に示すように，目的の画像の位置 (i, j)がわかったら，その位置のセグメント (A, B, C, D)を決
定し，(i, j)をセグメントの位置 (g, h)に変換する．さらに，セグメントの位置 (g, h)からデータアレイ

6ImageJ でについては，これまで作成したマクロで十分対応できる．
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Segment A

Segment B

Segment C

Segment D

Data format

1 38000A

B

D

C

Image(i,j)

i

j

C

g

h

Segment (g,h) Array(l)

A B C D

図 11: 検出画像とデータアレイとの変換

の位置 (ℓ)に変換される．その a(ℓ, b(ℓから，ようやくピクセルに対応する閾値電圧 mVが決定できる．
その電圧に対応したフォルダーにある Image000i.txtのピクセル位置 (i, j)のカウントを取り出す．

CdTe-systemのプログラムを理解するには，以上のしくみを理解することが必要である．

6.2 ピクセル単位でエネルギー較正した画像の比較

(a)各ピクセルごとに較正 (b)平均閾値電圧で較正

図 12: CdTe検出器のエネルギー較正による 70keV相当の画像 (電磁鋼板)

さて，前述の各ピクセルごとのエネルギー構成するツールが完成したので，正確なＸ線エネルギーに

よる画像を取得することができるようになった．図 12 (a)は，ピクセルごとの構成をした正確なエネル
ギー値による画像である．一方，図 12 (b)は検出器の平均，すなわち式 (2)から計算した閾値電圧を利
用してＸ線エネルギーを決定した画像である．

図の (a)と (b)を比較すると，ピクセルごとに較正した図 (a)の方が，図 (b)よりもカウント数も高く，
より鮮鋭な画像として捉えられている7．測定した結果を素早く概観したいのであれば，cdte2.f90で処

7測定画像を tiff で読み込み，ImageJ の 3D surface plot プロファイルで確認する必要がある．
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理して読み取ればよいが，ひずみ解析などに特定のＸ線エネルギーの画像を使用するには，E image.f90
で処理することが望ましい．

12



Appendix I: Fortran program
gfortranでコンパイルして利用する．各自の実験に合わせてカスタマイズすることが必要である8．

cdte.f90

プログラム cdte.f90 は，img i.txt からデータを読み出し，ImageJ で読めるテキスト画像ファイル
Image000i.txtに変換する．言語は gfortranで記述した．これを使うためには，table.txtに

1. エネルギー較正のデータファイルの個数

2. ファイル名のリスト

を用意しておく．エクセルでファイル名のリストを作っておくと良い．

!****************************************************
! Reading data from CdTe detector
! cdte.f90
! K. Suzuki, Niigata University, July 26, 2018
!****************************************************

program cdte

character filename*128
character bun*128
character a*128
character cfile*128

integer :: i,j,k,l
integer :: nf, loop
integer*4 :: x(0:94,0:399) !32bit data
integer*4 :: y(0:200,0:190) !32bit data
integer*4 :: I1,I2,I3,I4

write(6,*) "Do you set table.txt? (y)"
read(5,*) a

open(unit=12,file="table.txt",status=’old’)
read (12,*) nf

do loop = 1, nf
read(12,*) filename
write(*,fmt=’(a)’,advance=’no’) filename
open(unit=10,file=filename,status=’old’)
do i=1,13

read(10,*) bun
end do
do j=0,399

do i=0,94
read(10,*) k, l, x(i,j)

end do
end do
close(10)

! ----------------------- compose data file
! segment c ->1, B -> 2

n=0

! m=0-99:C, m=100:non, m=101-200: B

8Frotran のプログラミングでは，有用なサイト・書籍が用意されている．本ツール開発では，以下のサイト・書籍を活用した．
・Numerical Algorithms Group（NAG) のサイトの URL: http://www.nag-j.co.jp/fortran/index.html
・新井親夫『Fortran90 入門—基礎から再帰手続きまで』森北出版 (1998).
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do i=0,94,1
m=0
do j=299,200,-1

y(m,n)=x(i,j)
m=m+1

end do
m=m+1 ! 100 boundary pixel
do j=199,100,-1
y(m,n)=x(i,j)
m=m+1

end do
n=n+1
end do

n=n+1 ! 100 boundary pixel
do i=94,0,-1
m=0
do j=300,399,1

y(m,n)=x(i,j)
m=m+1

end do
m=m+1 ! 100 boundary pixel
do j=0,99,1

y(m,n)=x(i,j)
m=m+1

end do
n=n+1
end do

! calculation counts at the boundaries
do j=0,93

y(99,j)=int(y(99,j)*2/3)
y(101,j)=int(y(101,j)*2/3)
y(100,j)=int((y(99,j)+y(101,j))/2)

end do
do j=97,190
y(99,j)=int(y(99,j)*2/3)
y(101,j)=int(y(101,j)*2/3)
y(100,j)=int((y(99,j)+y(101,j))/2)

end do

do i=0,98
y(i,94)=int(y(i,94)*2/3)
y(i,96)=int(y(i,96)*2/3)
y(i,95)=int((y(i,94)+y(i,96))/2)

end do
do i=102,200
y(i,94)=int(y(i,94)*2/3)
y(i,96)=int(y(i,96)*2/3)
y(i,95)=int((y(i,94)+y(i,96))/2)

end do

I1=y(99,94)
I2=y(101,94)
I3=y(99,96)
I4=y(101,96)

y(99,94)=int(I1*4/9)
y(100,94)=int((I1+I2)*2/9)
y(101,94)=int(I2*4/9)

y(99,95)=int((I1+I3)*4/9)
y(100,95)=int((I1+I2+I3+I4)/9)
y(101,95)=int((I2+I4)*4/9)
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y(99,96)=int(I3*4/9)
y(100,96)=int((I3+I4)*2/9)
y(101,96)=int(I4*4/9)

! Output composed image for ImageJ

write (cfile, ’("Image", i4.4, ".txt")’) loop ! Image000x.txtを作る
open(unit=11,file=cfile,status=’unknown’)
do j=0,190,1
write(11,*) (y(i,j),i=0,200,1)

end do
close(11)
write(6,*) cfile

end do
close(12)
end program cdte

calibration.f90

calibration.f90は，エネルギー較正用プログラムである．蛍光Ｘ線を閾値電圧を変えながら測定した
データファイル img i.txtからデータを読み出し，閾値電圧で整理したカウント像および差分像を表示す
る．gnuplot用に c map 000i.txt (カウント像)と d map 000i.txt (差分像)並びに ImageJ用に stack i.txtお
よび stack-d i.txtを生成する．最後に，calibration.f90はファイル peak.datを出力する．この中に 38000
ピクセルのKα, Kβ の閾値電圧が記録されている．

stack i.txt および stack-d i.txt は，それぞれの専用フォルダー stack. stack-d に移動して，次に示す
Stack100.ijmのマクロ stack(100)および stack-d(100)で重ね合せ像を表示できる．この stack-d(100)で作
成した tiffファイルを読みながら，Kβ, Kαのピーク処理を施す xの範囲 v1, v2 (pixel単位)を調べ，用
意しておく．それが完了したら，Please make stack and stack-d folders. Ok?の問に対し yesを入力すると，
v1, v2の入力を求められる．最終的に，エネルギー較正に必要な peak.datが出力される．

!*******************************************
! calibration.f90 ver 2.0
! Calibration of CdTe detector
! by Kenji SUZUKI, Niigata University
! 380x100 files
!*******************************************

program calibration

character filename*128
character bun*128
character a*128
character cfile*128
real:: dx,y,z
integer :: dev(0:200)
integer :: i,j,k,l,p
integer :: V0, dV, n, loop, V
integer*4 :: x(0:170,0:40000) ! 32 bit data
integer*4 :: x3(0:170,0:40000) ! 32 bit data

! peak search
integer :: v1, v2, peak(1:100),m,u,p1,p2

write (*,fmt=’(a)’, advance=’no’) ’Do you set input.txt? (y)’
write(6,*)
read(5,*) a
open(unit=12,file=’calibration.txt’,status=’old’) ! list of reading files
read (12,*) V0,dV, n
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V=V0
do loop = 1, n

read(12,*) filename
! write(*,fmt=’(a)’,advance=’no’) filename

open(unit=10,file=filename,status=’old’)
write(6,*) filename
do i=1,13
read(10,*) bun

end do

p=0
do j=0,399
do i=0,94
read(10,*) k, l, x(loop,p)
p=p+1
end do
end do
close(10)

end do
close(12)

! Output calibration files

p=0

do i=1,100

write (cfile, ’("c_map_", i4.4, ".txt")’) i ! ここでファイル名を生成している
open(unit=11,file=cfile,status=’unknown’) ! files for gnuplot

write(11,*) ’#calibration map for gnu_plot’
write(11,*) ’# mV i counts’

do j=1,380
V=V0
x3(1,p)=x(1,p)
do k=2,n-1

x3(k,p)=Int((x(k-1,p)+x(k,p)+x(k+1,p))/3) ! 3 points simple moving average
write(11,*) V,p,x3(k,p)
V=V+dV

end do
x3(n,p)=x(n,p)
p=p+1
write(11,*) ’’ ! write LF

end do
close(11)

end do

! Search peak using 2nd derivatives

p=0

do i=1,100

write (cfile, ’("d_map_", i4.4, ".txt")’) i ! ここでファイル名を生成している
open(unit=11,file=cfile,status=’unknown’) ! files for gnuplot

write(11,*) ’#calibration map for gnu_plot’
write(11,*) ’# mV i counts’
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do j=1,380
V=V0
do k=2,n-1

dev(k)=(x3(k+1,p)-x3(k-1,p))/float(dV)/2.0
write(11,*) V,p,dev(k)
V=V+dV

end do
p=p+1
write(11,*) ’’ ! write LF

end do
close(11)

end do

! Output calibration files for ImageJ

p=0

do i=1,100
write(cfile,*) i
cfile=’stack_’//trim(adjustl(cfile))//’.txt’ !adjustlで左寄せにしてから trimで末尾の空
白除去，拡張子等をくっつける
open(unit=11,file=cfile,status=’unknown’) ! files with Text Image for ImageJ

do j=1,380
write(11,*) (x3(k,p), k=1,n,1)
p=p+1

end do
close(11)

end do

! Output calibration files for ImageJ

p=0

do i=1,100
write(cfile,*) i
cfile=’stack-d_’//trim(adjustl(cfile))//’.txt’ !adjustlで左寄せにしてから trimで末尾の
空白除去，拡張子等をくっつける
open(unit=11,file=cfile,status=’unknown’) ! files with Text Image for ImageJ

do j=1,380
do k=2,n-1

z=x3(k,p)
if (z .le. 10.0) then

z=50.0
end if
y=(x3(k+1,p)-x3(k-1,p))/dV/2/z*1000.0

if (y .lt. 0.0) then
y=0.0
end if

dev(k)=y
end do

write(11,*) (dev(k), k=2,n-1,1)
p=p+1

end do
close(11)

end do

! Peak search

write(6,*) ’Please make stack and stack-d folders. Ok? (yes)’
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read(5,*) a
open(unit=11, file=’peak.dat’, status=’unknown’)

write(6,*) ’Please input start and end pixel numbers v1, v2.’
read(5,*) v1,v2

do p=1,38000
do i=1,100

peak(i)=0
end do
do k=2,n-1

z=x3(k,p)
y=(x3(k+1,p)-x3(k-1,p))/dV/2/z*1000.0
if (y .lt. 0.0) then

y=0.0
end if
dev(k)=y
end do

i=1
do k=v1,v2
if (((dev(k+1)-dev(k)).lt. 0).and.((dev(k)-dev(k-1)).gt. 0)) then !peak

peak(i)=k
i=i+1

! write(6,*) k,dev(k)
end if

end do
m=i-1

! sorting
do j=m,2,-1
do i=2,j
if (dev(peak(i)).gt.dev(peak(i-1))) then
u=peak(i)
peak(i)=peak(i-1)

peak(i-1)=u
end if

end do
end do

do k=v1,v2
if((x(k,p).gt.1200000).or.(x(k,p).lt. -1200000)) then
peak(1)=0
peak(2)=0

end if
end do
if (peak(1).gt.peak(2)) then
p1=peak(1)
peak(1)=peak(2)
peak(2)=p1

end if

p1= dev(peak(1)) !Kβ
p2= dev(peak(2)) !Kα
write(11,*) p,V0+peak(1)*dV, p1, V0+peak(2)*dV, p2

end do
close(11)

end program calibration

evaluate.f90
!**********************************************************************
! Evaluation of peak.dat ver. 2
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! evaluate.f90
! Statics in calibration of pixels
! by K. Suzuki Niigata University
!********************************************************* Oct. 12, 2018

program evaluate

character*30 ::a,filename
integer :: x1(1:210)=0, x2(1:210)=0 ! Kb, Ka
integer :: i,n,v1(1:39000),v2(1:39000),j,m1=0,fault=0
real :: mean1=0.0,std1=0.0, mean2=0.0,std2=0.0
real :: y1,y2,z1, z2

! 1=Kb, 2=Ka
!
print *, ’Enter file name: ’
read ’(A)’, filename
open(11,file=filename,status=’old’)
n = 0
do

read(11,’()’,end=100)
n = n + 1

end do
100 close(11)
print *, n

open(unit=11,file=filename,status=’old’)

m=0
do i=1,n

read(11,*) j,v1(i),y1,v2(i),y2
if (v2(i).eq.-200) then
y2=0
fault=fault+1

else
m=m+1
j=-v1(i)

x1(j)=x1(j)+1
j=-v2(i)

x2(j)=x2(j)+1
end if

end do
close(11)

! mean
do i=40,199
mean1=mean1-real(x1(i)*i)
mean2=mean2-real(x2(i)*i)

end do
mean1=mean1/real(m)
mean2=mean2/real(m)

do i=40,199
z1=x1(i)*(real(i)+mean1)**2
std1=std1+z1

z2=x2(i)*(real(i)+mean2)**2
std2=std2+z2

end do
std1 = sqrt(std1/(m-1))
std2 = sqrt(std2/(m-1))

write(6,*) ’K-beta Mean =’,mean1, ’Std=’,std1
write(6,*) ’K-alpha Mean =’,mean2, ’Std=’,std2
write(6,*) ’ Number of data=’,m, ’Number of fault data=’, fault
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open(unit=10,file=’evaluation.dat’,status=’unknown’)
write(10,*) ’K-beta Mean =’,mean1, ’Std=’,std1
write(10,*) ’K-alpha Mean =’,mean2, ’Std=’,std2
write(10,*) ’ Number of data=’,m, ’Number of fault data=’, fault
do i=40,199
write(10,*) -i,x1(i), x2(i)

end do
close(10)

end program evaluate

cdte2.f90
!****************************************************
! Reading data from CdTe detector
! cdte2.f90, ver. 2.0
! K. Suzuki, Niigata University, Aug 21, 2018
!****************************************************

program cdte

character filename*128
character bun*128
character a*4, dir*6
character cfile*128,xfile*20

integer :: i,j,k,l, mV, p,ix,ie,mVe
integer :: nf, loop
integer*4 :: x(0:94,0:399) !32bit data
integer*4 :: y(0:200,0:190) !32bit data
integer*4 :: I1,I2,I3,I4

!write (*,fmt=’(a)’, advance=’no’) ’How many files for CdTe img.txt : ’
write(6,*) "Are you ready? (y)"
read(5,*) a

write(6,*) "Input p of strat img_p.txt="
read (5,*) p

write(6,*) "Input strat mV without sign"
read (5,*) mV

write(6,*) "Input end mV="
read (5,*) mVe

write(6,*) "Number of images for composition="
read (5,*) nf

do ie=1,mV-mVe+1

do loop = 1, nf
ix=p+(loop-1)*151
write(filename,*) ix
filename=’img_’//trim(adjustl(filename))//’.txt’
open(unit=10,file=filename,status=’old’)
do i=1,13
read(10,*) bun

! write(6,*) bun
end do

do j=0,399
do i=0,94
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read(10,*) k, l, x(i,j)
! write(6,*) k,l, x(i,j)

end do
end do
close(10)

! ----------------------- compose data file
! segment c ->1, B -> 2

n=0

!m=0-99:C, m=100:non, m=101-200: B
do i=0,94,1
m=0
do j=299,200,-1

y(m,n)=x(i,j)
m=m+1

end do
m=m+1 ! 100 boundary pixel
do j=199,100,-1
y(m,n)=x(i,j)
m=m+1

end do
n=n+1
end do

n=n+1 ! 100 boundary pixel

do i=94,0,-1
m=0
do j=300,399,1

y(m,n)=x(i,j)
m=m+1

end do
m=m+1 ! 100 boundary pixel
do j=0,99,1
y(m,n)=x(i,j)
m=m+1
end do
n=n+1
end do

! calculation counts at the boundaries
do j=0,93
y(99,j)=int(y(99,j)*2/3)
y(101,j)=int(y(101,j)*2/3)
y(100,j)=int((y(99,j)+y(101,j))/2)
end do
do j=97,190
y(99,j)=int(y(99,j)*2/3)
y(101,j)=int(y(101,j)*2/3)
y(100,j)=int((y(99,j)+y(101,j))/2)
end do

do i=0,98
y(i,94)=int(y(i,94)*2/3)
y(i,96)=int(y(i,96)*2/3)
y(i,95)=int((y(i,94)+y(i,96))/2)

end do
do i=102,200
y(i,94)=int(y(i,94)*2/3)
y(i,96)=int(y(i,96)*2/3)
y(i,95)=int((y(i,94)+y(i,96))/2)
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end do

I1=y(99,94)
I2=y(101,94)
I3=y(99,96)
I4=y(101,96)

y(99,94)=int(I1*4/9)
y(100,94)=int((I1+I2)*2/9)
y(101,94)=int(I2*4/9)

y(99,95)=int((I1+I3)*4/9)
y(100,95)=int((I1+I2+I3+I4)/9)
y(101,95)=int((I2+I4)*4/9)

y(99,96)=int(I3*4/9)
y(100,96)=int((I3+I4)*2/9)
y(101,96)=int(I4*4/9)

! Output composit image for ImageJ
write(dir,’(I4)’) mV

write (xfile,’("Image", i4.4, ".txt")’) loop ! ここでファイル名を生成している
cfile=trim(adjustl(dir))//"/"//xfile
write(6,*) cfile

open(unit=11,file=cfile,status=’unknown’)
do j=0,190,1
write(11,*) (y(i,j),i=0,200,1)
end do
close(11)

write(6,*) cfile
end do

p=p+1
mV=mV-1
end do
end program cdte

cdte2.f90
!****************************************************
! Reading data from CdTe detector
! cdte2.f90, ver. 2.0
! K. Suzuki, Niigata University, Aug 21, 2018
!****************************************************

program cdte

character filename*128
character bun*128
character a*4, dir*6
character cfile*128,xfile*20

integer :: i,j,k,l, mV, p,ix,ie,mVe
integer :: nf, loop
integer*4 :: x(0:94,0:399) !32bit data
integer*4 :: y(0:200,0:190) !32bit data
integer*4 :: I1,I2,I3,I4

!write (*,fmt=’(a)’, advance=’no’) ’How many files for CdTe img.txt : ’
write(6,*) "Are you ready? (y)"
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read(5,*) a

write(6,*) "Input p of strat img_p.txt="
read (5,*) p

write(6,*) "Input strat mV without sign"
read (5,*) mV

write(6,*) "Input end mV="
read (5,*) mVe

write(6,*) "Number of images for composition="
read (5,*) nf

do ie=1,mV-mVe+1

do loop = 1, nf
ix=p+(loop-1)*151
write(filename,*) ix
filename=’img_’//trim(adjustl(filename))//’.txt’
open(unit=10,file=filename,status=’old’)
do i=1,13
read(10,*) bun

! write(6,*) bun
end do

do j=0,399
do i=0,94

read(10,*) k, l, x(i,j)
! write(6,*) k,l, x(i,j)

end do
end do
close(10)

! ----------------------- compose data file
! segment c ->1, B -> 2

n=0

!m=0-99:C, m=100:non, m=101-200: B
do i=0,94,1
m=0
do j=299,200,-1

y(m,n)=x(i,j)
m=m+1

end do
m=m+1 ! 100 boundary pixel
do j=199,100,-1
y(m,n)=x(i,j)
m=m+1

end do
n=n+1
end do

n=n+1 ! 100 boundary pixel

do i=94,0,-1
m=0
do j=300,399,1

y(m,n)=x(i,j)
m=m+1

end do
m=m+1 ! 100 boundary pixel
do j=0,99,1
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y(m,n)=x(i,j)
m=m+1

end do
n=n+1
end do

! calculation counts at the boundaries
do j=0,93
y(99,j)=int(y(99,j)*2/3)
y(101,j)=int(y(101,j)*2/3)
y(100,j)=int((y(99,j)+y(101,j))/2)
end do
do j=97,190
y(99,j)=int(y(99,j)*2/3)
y(101,j)=int(y(101,j)*2/3)
y(100,j)=int((y(99,j)+y(101,j))/2)
end do

do i=0,98
y(i,94)=int(y(i,94)*2/3)
y(i,96)=int(y(i,96)*2/3)
y(i,95)=int((y(i,94)+y(i,96))/2)

end do
do i=102,200
y(i,94)=int(y(i,94)*2/3)
y(i,96)=int(y(i,96)*2/3)
y(i,95)=int((y(i,94)+y(i,96))/2)

end do

I1=y(99,94)
I2=y(101,94)
I3=y(99,96)
I4=y(101,96)

y(99,94)=int(I1*4/9)
y(100,94)=int((I1+I2)*2/9)
y(101,94)=int(I2*4/9)

y(99,95)=int((I1+I3)*4/9)
y(100,95)=int((I1+I2+I3+I4)/9)
y(101,95)=int((I2+I4)*4/9)

y(99,96)=int(I3*4/9)
y(100,96)=int((I3+I4)*2/9)
y(101,96)=int(I4*4/9)

! Output composit image for ImageJ
write(dir,’(I4)’) mV

write (xfile,’("Image", i4.4, ".txt")’) loop ! ここでファイル名を生成している
cfile=trim(adjustl(dir))//"/"//xfile
write(6,*) cfile

open(unit=11,file=cfile,status=’unknown’)
do j=0,190,1
write(11,*) (y(i,j),i=0,200,1)
end do
close(11)

write(6,*) cfile
end do

p=p+1
mV=mV-1
end do
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end program cdte

CdTe E.f90

CdTe E.f90は，蛍光Ｘ線の検出結果を calibration.f90で処理して得られた各ピクセルの蛍光Ｘ線のピー
ク位置 (Kβ, Kαの電圧値を格納した peak.datを使用する．そのため，各 peak.datのファイル名をW.dat,
Pb.datに renameして読み込ませる．CdTe E.f90は，各ピクセルのエネルギー値の較正式のデータ ı, ai,
bi を計算して，CdTe E.datとして出力する．

!------------------------- Energy calibration of CdTe detector ---------------
! CdTe_E.f90 ver. 2.0
! by Kenji SUZUKI, Niigata University, 12 October, 2018
!*****************************************************************************
! 本バージョンでは Pb,W, Sn, Mo の Kaのデータを読むように変更．

program CdTe_E

character*30 :: filename
integer :: i,j,k,l
real :: mV(1:38000,1:4), value1,value2, Kb,d1,d2,d3,d4
real :: E(1:4), a(1:38000),b(1:38000)
real :: m11,m12,c1,c2,n

! data E/84.94,74.25,67.24,58.87/ ! E(1)=Pb-Kβ, E(2)=Pb-Kα, E(3)=W-Kβ, E(4)=W-K
α
data E/74.25, 58.87, 25.20, 17.44/ ! E(1)=Pb-Ka, E(2)=W-Kα, E(3)=Sn-Ka, E(4)=Mo-K
α

! read peak.dat
print *, ’Enter file name for Pb: ’
read ’(A)’, filename
open(11,file=filename,status=’old’)

do j=1,38000
read(11,*) i,Kb,value1,mV(i,1),value2

end do
close(11)

print *, ’Enter file name for W: ’
read ’(A)’, filename
open(11,file=filename,status=’old’)

do j=1,38000
read(11,*) i,Kb,value1,mV(i,2),value2

end do
close(11)

print *, ’Enter file name for Sn: ’
read ’(A)’, filename
open(11,file=filename,status=’old’)

do j=1,38000
read(11,*) i,Kb,value1,mV(i,3),value2

end do
close(11)

print *, ’Enter file name for Mo: ’
read ’(A)’, filename
open(11,file=filename,status=’old’)

do j=1,38000
read(11,*) i,Kb,value1,mV(i,4),value2

end do
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close(11)

! Least squares method
n=4.0
do i=1,38000

m11=0.0
m12=0.0
c1=0.0
c2=0.0
do j=1,4
m11=m11+mV(i,j)**2
m12=m12+mV(i,j)
c1=c1+E(j)*mV(i,j)
c2=c2+E(j)

end do

a(i)=(m12*c2-n*c1)/(m12**2-n*m11)
b(i)=(m12*c1-m11*c2)/(m12**2-n*m11)

d1=mV(i,1)
d2=mV(i,2)
d3=mV(i,3)
d4=mV(i,4)

if ((d1.LT.-199.).or.(d2.LT.-199.).or.(d3.LT.-199.).or.(d4.LT.-199.)) then
a(i)=0.0
b(i)=0.0

end if
end do

! file out CdTe_E.dat
open(12,file=’CdTe_E.dat’, status=’unknown’)

do i=1,38000
write(12,*) i, a(i), b(i)

end do
close(12)

end program CdTe_E

E image.f90
E image.f90 は，要求されたＸ線エネルギー E に対応するＸ線回折像を得るために，画像の各ピク
セル (i, j) に対応した閾値電圧を CdTe E.dat に基づいて計算し，それらの閾値電圧フォルダーにある
Image000i.txt からピクセルのカウントを取得して，画像データを作成し，ワークディレクトリーに
Image000i.txtを出力する.

!********************** Image by X-ray energy *********************
! E_image.f90 ver1.0
! Kenji SUZUKI, Niigata University
!----------------------------------------- 20th September, 2018 -----------

program E_image
real :: a(1:38000),b(1:38000), En, mV
integer :: i,j,k,l,n,dir
integer*4 :: y(0:200,0:190),br !32bit data,
integer*4 :: I1,I2,I3,I4
character cfile*128

! read a and b for calibration of CdTe-detector
print *, ’CdTe_E.dat’
open(11,file=’CdTe_E.dat’, status=’old’)

do i=1,38000
read(11,*) j, a(j), b(j)

end do
close(11)
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print *, ’Input number of image file set, n=’ !6 or 15
read(5,*) n
print *, ’Input X-ray energy of image, En (keV)=’
read(5,*) En

do k=1,n

do j=0,190
do i=0,200
call Pixel (i,j,l)
if ((l.ne.0).and.(a(l).ne.0.0)) then
mV=(En-b(l))/a(l)
dir=nint(mV)
else
dir=0

end if
! print *, i,j,dir

if ((dir .ge. -210).and.(dir .lt. -60)) then
call Bright(i,j,dir,br,k)
y(i,j)=br

else
y(i,j)=0

end if
end do
print *,j

end do

! calculation counts at the boundaries
do j=0,93

y(99,j)=int(y(99,j)*2/3)
y(101,j)=int(y(101,j)*2/3)
y(100,j)=int((y(99,j)+y(101,j))/2)

end do
do j=97,190

y(99,j)=int(y(99,j)*2/3)
y(101,j)=int(y(101,j)*2/3)
y(100,j)=int((y(99,j)+y(101,j))/2)

end do

do i=0,98
y(i,94)=int(y(i,94)*2/3)
y(i,96)=int(y(i,96)*2/3)
y(i,95)=int((y(i,94)+y(i,96))/2)

end do
do i=102,200

y(i,94)=int(y(i,94)*2/3)
y(i,96)=int(y(i,96)*2/3)
y(i,95)=int((y(i,94)+y(i,96))/2)

end do

I1=y(99,94)
I2=y(101,94)
I3=y(99,96)
I4=y(101,96)

y(99,94)=int(I1*4/9)
y(100,94)=int((I1+I2)*2/9)
y(101,94)=int(I2*4/9)

y(99,95)=int((I1+I3)*4/9)
y(100,95)=int((I1+I2+I3+I4)/9)
y(101,95)=int((I2+I4)*4/9)

y(99,96)=int(I3*4/9)
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y(100,96)=int((I3+I4)*2/9)
y(101,96)=int(I4*4/9)

! Output energy image for ImageJ
! Image000i.txtは，Composition.ijmのマクロを利用して合成します．

write (cfile, ’("Image", i4.4, ".txt")’) k ! ここでファイル名を生成している
open(unit=12,file=cfile,status=’unknown’)
do j=0,190,1

write(12,*) (y(i,j),i=0,200,1)
end do
close(12)
write(6,*) cfile
end do

end program E_image

!---------------------------------------SUBROUTINE -----------------------------
! transration of parameters, Image(i,j) > Segment(g,h) > Array(l)
subroutine Pixel (i,j,l)
integer :: i,j,l,g,h

! translation from Image(i,j) into Segments( A, B, C, D
if ((i<=99).and.(j<=94)) then ! segment C

g=94-j
h=299-i
l=95*h+g

else if ((i>=101).and.(j<=94)) then ! segment B
g=j
h=200-i
l=95*h+g

else if ((i<=99).and.(j>=96)) then ! segment D
g=190-j
h=i+300
l=95*h+g

else if ((i>=101).and.(j>=96)) then ! segment A
g=190-j
h=200-i
l=95*h+g

else if ((i==100).or.(j==95)) then ! boundary
l=0

end if
end subroutine Pixel

! Reading brightness from each energy directory
subroutine Bright(m,n,dir,a,k)
integer*4 :: y(0:200,0:190),a !32bit data, a: brightness
integer :: i,j,k,dir,mV, m,n
character cfile*128,xfile*20,fl*6

! input file
if (dir.ne.0) then

mV=-dir
write(fl,’(I4)’) mV
write (xfile,’("Image", i4.4, ".txt")’) k ! ここでファイル名 xfileを生成してい

る
cfile=trim(adjustl(fl))//"/"//xfile ! cfile= folder+/+Image i .txt を作成.

! write(6,*) cfile
open(unit=11,file=cfile,status=’old’)
do j=0,n-1,1
read(11,*) !読飛ばし

end do
do j=n,n
read(11,*) (y(i,j),i=0,m,1) !読込

28



end do
close(11)
a=y(m,n)

else
a=0

end if
end subroutine Bright

E2 image.f90
E2 image.f90は，E image.f90と同じであるが，Composition.ijmを利用する必要がなく，Ｘ線エネル
ギー E1 ∼ E2 (keV)の像 1 keVステップで連続して作成する．

!********************** Image by X-ray energy *********************
! E2_image.f90 ver3.0
! Kenji SUZUKI, Niigata University
!----------------------------------------- 18th October, 2018 -----

program E_image
real :: a(1:38000),b(1:38000), En, mV
integer :: i,j,k,l,n,dir,m1,n1,keV,e1,e2
integer*4 :: y(0:200,0:190),br !32bit data,
integer*4 :: I1,I2,I3,I4
character cfile*128

! read a and b for calibration of CdTe-detector
print *, ’CdTe_E.dat’
open(11,file=’CdTe_E.dat’, status=’old’)

do i=1,38000
read(11,*) j, a(j), b(j)

end do
close(11)

print *, ’Input number of image file set, m,n (m x n, 2x3, 4x5)=’ !
read(5,*) m1, n1
n=m1*n1
print *, ’Input range of X-ray energy, E1, E2 (keV)=’
read(5,*) e1,e2

do keV=e1,e2
En=float(keV)

do k=1,n

do j=0,190
do i=0,200
call Pixel (i,j,l)
if ((l.ne.0).and.(a(l).ne.0.0)) then
mV=(En-b(l))/a(l)
dir=nint(mV)
else
dir=0

end if
! print *, i,j,dir

if ((dir .ge. -210).and.(dir .lt. -60)) then
call Bright(i,j,dir,br,k)
y(i,j)=br

else
y(i,j)=0

end if
end do
print *,j

end do
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! calculation counts at the boundaries
do j=0,93
y(99,j)=int(y(99,j)*2/3)
y(101,j)=int(y(101,j)*2/3)
y(100,j)=int((y(99,j)+y(101,j))/2)

end do
do j=97,190
y(99,j)=int(y(99,j)*2/3)
y(101,j)=int(y(101,j)*2/3)
y(100,j)=int((y(99,j)+y(101,j))/2)

end do

do i=0,98
y(i,94)=int(y(i,94)*2/3)
y(i,96)=int(y(i,96)*2/3)
y(i,95)=int((y(i,94)+y(i,96))/2)

end do
do i=102,200
y(i,94)=int(y(i,94)*2/3)
y(i,96)=int(y(i,96)*2/3)
y(i,95)=int((y(i,94)+y(i,96))/2)

end do

I1=y(99,94)
I2=y(101,94)
I3=y(99,96)
I4=y(101,96)

y(99,94)=int(I1*4/9)
y(100,94)=int((I1+I2)*2/9)
y(101,94)=int(I2*4/9)

y(99,95)=int((I1+I3)*4/9)
y(100,95)=int((I1+I2+I3+I4)/9)
y(101,95)=int((I2+I4)*4/9)

y(99,96)=int(I3*4/9)
y(100,96)=int((I3+I4)*2/9)
y(101,96)=int(I4*4/9)

! Output energy image for ImageJ
! Image000i.txtは，Composition.ijmのマクロを利用して合成します．

write (cfile, ’("Image", i4.4, ".txt")’) k ! ここでファイル名を生成している
open(unit=12,file=cfile,status=’unknown’)
do j=0,190,1

write(12,*) (y(i,j),i=0,200,1)
end do
close(12)
write(6,*) cfile
end do

call Composition(m1,n1,keV) ! このサブルーチンで keV画像を合成する．
end do

end program E_image

!---------------------------------------SUBROUTINE -----------------------------
! transration of parameters, Image(i,j) > Segment(g,h) > Array(l)
subroutine Pixel (i,j,l)
integer :: i,j,l,g,h

! translation from Image(i,j) into Segments( A, B, C, D
if ((i<=99).and.(j<=94)) then ! segment C
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g=94-j
h=299-i
l=95*h+g

else if ((i>=101).and.(j<=94)) then ! segment B
g=j
h=200-i
l=95*h+g

else if ((i<=99).and.(j>=96)) then ! segment D
g=190-j
h=i+300
l=95*h+g

else if ((i>=101).and.(j>=96)) then ! segment A
g=190-j
h=200-i
l=95*h+g

else if ((i==100).or.(j==95)) then ! boundary
l=0

end if
end subroutine Pixel

! Reading brightness from each energy directory
subroutine Bright(m,n,dir,a,k)
integer*4 :: y(0:200,0:190),a !32bit data, a: brightness
integer :: i,j,k,dir,mV, m,n
character cfile*128,xfile*20,fl*6

! input file
if (dir.ne.0) then

mV=-dir
write(fl,’(I4)’) mV
write (xfile,’("Image", i4.4, ".txt")’) k ! ここでファイル名 xfileを生成してい

る
cfile=trim(adjustl(fl))//"/"//xfile ! cfile= folder+/+Image i .txt を作成.

! write(6,*) cfile
open(unit=11,file=cfile,status=’old’)
do j=0,n-1,1
read(11,*) !読飛ばし

end do
do j=n,n
read(11,*) (y(i,j),i=0,m,1) !読込

end do
close(11)
a=y(m,n)

else
a=0

end if
end subroutine Bright

!-------------------- SUBROUTINE composition -------------------
subroutine Composition(m,n,keV)
integer :: i,j,m,n,keV, k,l, No,h
integer*4 :: x(1:2000,1:2000),y(1:2000) !
character cfile*128

No=m*n
do j=1,n

do i=1,m
write (cfile,’("Image", i4.4, ".txt")’) No ! Image000No.txt を用意
print*,cfile
open(unit=12,file=cfile,status=’old’)
do l=1+(j-1)*190,j*190
read(12,*) (y(h),h=1,200,1)
h=1
do k=1+(i-1)*200,i*200
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x(k,l)=y(h)
h=h+1

end do
end do
close(12)
No=No-1

end do
end do

! xxkeV.txt
write (cfile,*) keV ! ここでファイル名を生成
cfile=trim(adjustl(cfile))//’keV.txt’
print *,cfile
open(unit=11,file=cfile,status=’unknown’)

do j=1,n*190
write(11,*) (x(i,j),i=1,200*m,1)

end do
close(11)

end subroutine Composition

Appendix II: Macro-program for ImageJ
ImageJのマクロプログラムである．各自の実験に合わせてカスタマイズして利用することが必要であ
る9．

Composition.ijm

Composition.ijmは，ImageJマクロであり，ImageJで Image0001.txt ∼ Image000n.txtまで読み込み．ス
タックを作成してから，n個の画像を貼り合わせるマクロである．なお，組み合わせは，2×3, 3×5,3×3

の 3種類のマクロプログラムを示す10．Image000n.txtを格納している作業ホルダーを選択すれば，読み
取りを開始します．ImageJの logの windowに読み取ったファイルを順番に示します．

macro "Compose 2X3 [1]"{
//input Image files, Image to stack and then Make stack

dir = getDirectory("Choose a Directory");
for (i=0; i<6;i++){
j=6-i;
cnt = "0000"+j;
path1 ="open="+dir+"Image"+substring(cnt,lengthOf(cnt)-4,lengthOf(cnt))+".txt";
print(path1);
run("Text Image... ", path1);
setMinAndMax(0, 1000);
run("Fire");
}

// make stack, make montage
run("Images to Stack", "name=Stack title=[] use");
run("Make Montage...", "columns=2 rows=3 scale=1");
}

macro "Compose 3X5 [2]"{
dir = getDirectory("Choose a Directory");
for (i=0; i<15;i++){
j=15-i;

9ImageJ の利用に際しては有用な書籍やサイトが多数用意されている．本ツール開発には以下の書籍，サイトを活用した．
・三浦耕太，塚田祐基『ImageJ ではじめる生物画像解析』学研プラス (2016).
・ImageJ 日本語情報 URL: http://seesaawiki.jp/w/imagej/

10マクロの見出し [1], [2], [3] はキーボードの数値キーでマクロが作動することを意味している．
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cnt = "0000"+j;
path1 ="open="+dir+"Image"+substring(cnt,lengthOf(cnt)-4,lengthOf(cnt))+".txt";
print(path1);
run("Text Image... ", path1);
setMinAndMax(0, 1000);
run("Fire");

}
// make stack, make montage

run("Images to Stack", "name=Stack title=[] use");
run("Make Montage...", "columns=3 rows=5 scale=1");

}

macro "Compose 3X3 [3]"{
//input Image files, Image to stack and then Make stack

dir = getDirectory("Choose a Directory");
for (i=0; i<9;i++){
j=9-i;
cnt = "0000"+j;
path1 ="open="+dir+"Image"+substring(cnt,lengthOf(cnt)-4,lengthOf(cnt))+".txt";
print(path1);
run("Text Image... ", path1);
setMinAndMax(0, 1000);
run("Fire");

}
// make stack, make montage
run("Images to Stack", "name=Stack title=[] use");
run("Make Montage...", "columns=3 rows=3 scale=1");
}

Stack100.ijm

Stack100.txtは，閾値電圧の変化に伴うカウント数と差分の動画を作成する ImageJのマクロプログラ
ムである．

//　カウント
macro "Stack (95) " {
dir = getDirectory("Choose a Directory");
list = getFileList(dir);

for (i=1; i<list.length+1;i++){
path1 = "open="+ dir+"stack_"+i+".txt";
run("Text Image... ", path1);
run("16 colors");
//run("Brightness/Contrast...");
setMinAndMax(0, 3000);

}
run("Images to Stack", "name=Stack title=[] use");

}

// 差分
macro "Stack-d (95)" {
dir = getDirectory("Choose a Directory");
list = getFileList(dir);

for (i=1; i<list.length+1;i++){
path1 = "open="+ dir+"stack-d_"+i+".txt";
run("Text Image... ", path1);
run("16 colors");
//run("Brightness/Contrast...");
setMinAndMax(0, 7000);

}
run("Images to Stack", "name=Stack-d title=[] use");

}
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all image.ijm
// File name all_image.ijm
// ImageJ macro to make images of 2x3 by CdTe detector
// (Set up each directory of mV before processing)

macro "Compose_all_2x3"{

//imgのあるディレクトリ dirを指定
dir = getDirectory("Choose a Directory");

for (j=210;j>59;j--){
dir1 = dir+j+"/";
print(dir1);
//input Image files, Image to stack and then Make stack
for (i=6; i>0;i--){
cnt = "0000"+i;
path1 ="open="+dir1+"Image"+substring(cnt,lengthOf(cnt)-4,lengthOf(cnt))+".txt";
print(path1);
run("Text Image... ", path1);
setMinAndMax(0, 1000);
run("Fire");

}
// make stack, make montage
run("Images to Stack", "name=Stack title=[] use");
run("Make Montage...", "columns=2 rows=3 scale=1");

dir1=dir1+"P1-"+j+".tif";
// 合成画像を.tifで保存して，ウィンドウを閉じる，ファイル名は dir1
saveAs("Tiff", dir1);
close();
selectWindow("Stack");
close();
}

}

macro "Compose_all_3x5"{

//imgのあるディレクトリ dirを指定
dir = getDirectory("Choose a Directory");

for (j=210;j>59;j--){
dir1 = dir+j+"/";
print(dir1);
//input Image files, Image to stack and then Make stack
for (i=15; i>0;i--){
cnt = "0000"+i;
path1 ="open="+dir1+"Image"+substring(cnt,lengthOf(cnt)-4,lengthOf(cnt))+".txt";
print(path1);
run("Text Image... ", path1);
setMinAndMax(0, 1000);
run("Fire");

}
// make stack, make montage
run("Images to Stack", "name=Stack title=[] use");
run("Make Montage...", "columns=3 rows=5 scale=1");

dir1=dir1+"P2-"+j+".tif";
// 合成画像を.tifで保存して，ウィンドウを閉じる，ファイル名は dir1
saveAs("Tiff", dir1);
close();
selectWindow("Stack");
close();
}

}
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// すべて P1-xxx.tifを重ね合わせる．stackは動画として tifで保存し，ImageJで再生．
macro "Stack_all(2x3)"{

//imgのあるディレクトリ dirを指定
dir = getDirectory("Choose a Directory");

for (j=210;j>59;j--){
dir1 = dir+j+"/";
path1 =dir1+"P1-"+j+".tif";
print(path1);
open(path1);
setMinAndMax(0, 1000);
run("Fire");
}
// make stack, make montage
run("Images to Stack", "name=Stack title=[] use");

}

// すべて P2-xxx.tifを重ね合わせる．stackは動画として tifで保存し，ImageJで再生．
macro "Stack_all(3x5)"{

//imgのあるディレクトリ dirを指定
dir = getDirectory("Choose a Directory");

for (j=210;j>59;j--){
dir1 = dir+j+"/";
path1 =dir1+"P2-"+j+".tif";
print(path1);
open(path1);
setMinAndMax(0, 1000);
run("Fire");
}
// make stack, make montage
run("Images to Stack", "name=Stack title=[] use");

}

// P1-i.tif=P1-i+1.tiff - P1-i-1.tiff
macro "Diff_all (2x3)"{

//imgのあるディレクトリを指定 dir
dir = getDirectory("Choose a Directory");

for (j=209;j>61;j--){
i=j+1;
k=j-1;
dir_i = dir+i+"/";
file_i = "P1-"+i+".tif";
path_i =dir_i+file_i;
open(path_i);
setMinAndMax(0, 1000);
run("Fire");

dir_k = dir+k+"/";
file_k = "P1-"+k+".tif";
path_k =dir_k+file_k;
open(path_k);
setMinAndMax(0, 1000);
run("Fire");

// Diffrential
imageCalculator("Subtract create", file_k,file_i);
file_k="Result of "+ file_k;
selectWindow(file_k);
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//run("Brightness/Contrast...");
run("16 colors");
setMinAndMax(-4, 80);

file_j = dir+j+"/P1-"+j+"diff.tif";
saveAs("Tiff", file_j);
print(file_j);
run("Close All");
}

}

// P2-i.tif=P2-i+1.tiff - P2-i-1.tiff
macro "Diff_all (3x5)"{

//imgのあるディレクトリを指定 dir
dir = getDirectory("Choose a Directory");

for (j=209;j>61;j--){
i=j+1;
k=j-1;
dir_i = dir+i+"/";
file_i = "P2-"+i+".tif";
path_i =dir_i+file_i;
open(path_i);
setMinAndMax(0, 1000);
run("Fire");

dir_k = dir+k+"/";
file_k = "P2-"+k+".tif";
path_k =dir_k+file_k;
open(path_k);
setMinAndMax(0, 1000);
run("Fire");

// Diffrential
imageCalculator("Subtract create", file_k,file_i);
file_k="Result of "+ file_k;
selectWindow(file_k);
//run("Brightness/Contrast...");
run("16 colors");
setMinAndMax(-4, 80);

file_j = dir+j+"/P2-"+j+"diff.tif";
saveAs("Tiff", file_j);
print(file_j);
run("Close All");

}
}

// すべての P1-xxxdiff.tifを重ね合わせる．stackは動画として tifで保存し，ImageJで再生．
macro "Diff_stack_all(2x3)"{

//imgのあるディレクトリ dirを指定
dir = getDirectory("Choose a Directory");

for (j=209;j>60;j--){
dir1 = dir+j+"/";
path1 =dir1+"P1-"+j+"diff.tif";
print(path1);
open(path1);
setMinAndMax(-5,80);
//run("Brightness/Contrast...");
run("16 colors");
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}
// make stack, make montage
run("Images to Stack", "name=Stack title=[] use");

}

// すべての P2-xxxdiff.tifを重ね合わせる．stackは動画として tifで保存し，ImageJで再生．
macro "Diff_stack_all(3x5)"{

//imgのあるディレクトリ dirを指定
dir = getDirectory("Choose a Directory");

for (j=209;j>60;j--){
dir1 = dir+j+"/";
path1 =dir1+"P2-"+j+"diff.tif";
print(path1);
open(path1);
setMinAndMax(-5,80);
//run("Brightness/Contrast...");
run("16 colors");
}
// make stack, make montage
run("Images to Stack", "name=Stack title=[] use");

}

P1-P2.ijm
macro "P1(2x3)"{
//imgのあるディレクトリ dirを指定
dir = getDirectory("Choose a Directory");

for (j=210;j>59;j--){
dir1 = dir+j+"/";
print(dir1);
//input Image files, Image to stack and then Make stack
for (i=6; i>0;i--){
cnt = "0000"+i;
path1 ="open="+dir1+"Image"+substring(cnt,lengthOf(cnt)-4,lengthOf(cnt))+".txt";
run("Text Image... ", path1);
setMinAndMax(0, 1000);
run("Fire");

}
// make stack, make montage
run("Images to Stack", "name=Stack title=[] use");
run("Make Montage...", "columns=2 rows=3 scale=1");
//メジアンフィルター
run("Fire");run("Median...", "radius=2");
//移動平均
run("Mean...", "radius=2");
dir1=dir1+"P1-"+j+".tif";
// 合成画像を.tifで保存して，ウィンドウを閉じる，ファイル名は dir1
saveAs("Tiff", dir1);
print(dir1);
close();
selectWindow("Stack");
close();
}

//imgのあるディレクトリ dirを指定
// dir = getDirectory("Choose a Directory");

for (j=210;j>59;j--){
dir1 = dir+j+"/";
path1 =dir1+"P1-"+j+".tif";
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print(path1);
open(path1);
setMinAndMax(0, 1000);
run("Fire");

}
// make stack, make montage
run("Images to Stack", "name=Stack title=[] use");

path1=dir+"P1_stack.tif";
print(path1);
saveAs("Tiff", path1);
close();

// P1-i.tif=P2-i+1.tiff - P1-i-1.tiff

for (j=209;j>60;j--){
i=j+1;
k=j-1;
dir_i = dir+i+"/";
file_i = "P1-"+i+".tif";
path_i =dir_i+file_i;
open(path_i);
setMinAndMax(0, 1000);
run("Fire");

dir_k = dir+k+"/";
file_k = "P1-"+k+".tif";
path_k =dir_k+file_k;
open(path_k);
setMinAndMax(0, 1000);
run("Fire");

// Diffrential
imageCalculator("Subtract create", file_k,file_i);
file_k="Result of "+ file_k;
selectWindow(file_k);
//run("Brightness/Contrast...");
run("16 colors");
setMinAndMax(-4, 80);

file_j = dir+j+"/P1-"+j+"diff.tif";
saveAs("Tiff", file_j);
print(file_j);
run("Close All");

}

for (j=209;j>60;j--){
dir1 = dir+j+"/";
path1 =dir1+"P1-"+j+"diff.tif";
print(path1);
open(path1);
setMinAndMax(-5,80);
//run("Brightness/Contrast...");
run("16 colors");

}
// make stack
run("Images to Stack", "name=Stack title=[] use");

path1=dir+"P1_diff_stack.tif";
print(path1);
saveAs("Tiff", path1);
close();
print("Complete P1!");

}
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//---------------------------------
macro "P2(3x5)"{
//imgのあるディレクトリ dirを指定
dir = getDirectory("Choose a Directory");

for (j=210;j>59;j--){
dir1 = dir+j+"/";
print(dir1);
//input Image files, Image to stack and then Make stack
for (i=15; i>0;i--){
cnt = "0000"+i;
path1 ="open="+dir1+"Image"+substring(cnt,lengthOf(cnt)-4,lengthOf(cnt))+".txt";
run("Text Image... ", path1);
setMinAndMax(0, 1000);
run("Fire");

}
// make stack, make montage
run("Images to Stack", "name=Stack title=[] use");
run("Make Montage...", "columns=3 rows=5 scale=1");
run("Fire");run("Median...", "radius=2");
run("Mean...", "radius=2");

dir1=dir1+"P2-"+j+".tif";
// 合成画像を.tifで保存して，ウィンドウを閉じる，ファイル名は dir1
print(dir1);
saveAs("Tiff", dir1);
close();
selectWindow("Stack");
close();
}

for (j=210;j>59;j--){
dir1 = dir+j+"/";
path1 =dir1+"P2-"+j+".tif";
print(path1);
open(path1);
setMinAndMax(0, 1000);
run("Fire");
}
// make stack, make montage
run("Images to Stack", "name=Stack title=[] use");

path1=dir+"P2_stack.tif";
print(path1);
saveAs("Tiff", path1);
close();

// P2-i.tif=P2-i+1.tiff - P2-i-1.tiff

for (j=209;j>60;j--){
i=j+1;
k=j-1;
dir_i = dir+i+"/";
file_i = "P2-"+i+".tif";
path_i =dir_i+file_i;
open(path_i);
setMinAndMax(0, 1000);
run("Fire");

dir_k = dir+k+"/";
file_k = "P2-"+k+".tif";
path_k =dir_k+file_k;
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open(path_k);
setMinAndMax(0, 1000);
run("Fire");

// Diffrential
imageCalculator("Subtract create", file_k,file_i);
file_k="Result of "+ file_k;
selectWindow(file_k);
//run("Brightness/Contrast...");
run("16 colors");
setMinAndMax(-4, 80);

file_j = dir+j+"/P2-"+j+"diff.tif";
saveAs("Tiff", file_j);
print(file_j);
run("Close All");

}

for (j=209;j>60;j--){
dir1 = dir+j+"/";
path1 =dir1+"P2-"+j+"diff.tif";
print(path1);
open(path1);
setMinAndMax(-5,80);
//run("Brightness/Contrast...");
run("16 colors");

}
// make stack
run("Images to Stack", "name=Stack title=[] use");
path1=dir+"P2_diff_stack.tif";
print(path1);
saveAs("Tiff", path1);
close();
print("Complete P2!");

}

spot max.ijm
//--------------------------------- spot_max.ijm -----
macro "Spot_max_P1"{
//imgのあるディレクトリ dirを指定
dir = getDirectory("Choose a Directory");
//getNumber("prompt", defaultValue)を使って，数値をキー入力できる．
//getString("prompt", "default")を利用すると，文字も入力できる．
x = getNumber("x=",x);
y = getNumber("y=",y);
xl = getNumber("lx=",xl);
yl = getNumber("ly=",yl);

for (j=209;j>60;j--){
dir_j = dir+j+"/";
file_j = "P1-"+j+"diff_F.tif";
path_j =dir_j+file_j;
open(path_j);
setMinAndMax(1, 200);
run("Fire");
run("Set Measurements...", "min redirect=None decimal=3");
makeRectangle(x, y, xl, yl);
run("Measure");
close();
}
print("Complete P1!");
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}

macro "Spot_max_P2"{
//imgのあるディレクトリ dirを指定
dir = getDirectory("Choose a Directory");
//getNumber("prompt", defaultValue)を使って，数値をキー入力できる．
//getString("prompt", "default")を利用すると，文字も入力できる．
x = getNumber("x=",x);
y = getNumber("y=",y);
xl = getNumber("lx=",xl);
yl = getNumber("ly=",yl);

for (j=209;j>60;j--){
dir_j = dir+j+"/";
file_j = "P2-"+j+"diff_F.tif";
path_j =dir_j+file_j;
open(path_j);
setMinAndMax(1, 200);
run("Fire");
run("Set Measurements...", "min redirect=None decimal=3");
makeRectangle(x, y, xl, yl);
run("Measure");
close();
}
print("Complete P2!");

}

keV-stack-diff.ijm

keV-stack-diff.ijmは， E image.f90でつくられた画像ファイル群 i keV.txtからスタック像や差分像を
つくるための ImageJマクロです．

// keVファイルのスタック像作成 keV-stack.ijm
macro "Make stack for keV" {

dir = getDirectory("Choose a Directory"); //directryの選択
X = getNumber("First XkeV, X=",X); //最初のファイル
n = getNumber("Number of files n=",n); //読込みファイル数
max=X+n+1; //読み込み終了条件

for (i=X; i<max;i++){
path1 = "open="+ dir+i+"keV.txt"; //読込みファイル名
run("Text Image... ", path1); //テキストイメージの読込み
run("Fire"); //Image Tableとして fireスタイルを定義
setMinAndMax(0, 5000); //run("Brightness/Contrast...");の min,max指定

run("Median...", "radius=1");
run("Mean...", "radius=1");
}
run("Images to Stack", "name=Stack title=[] use");

}

// keVファイルの差分像の作成
macro "Make diff for keV" {
dir = getDirectory("Choose a Directory"); //directryの選択

X = getNumber("First XkeV, X=",X); //最初のファイル
n = getNumber("Number of files n=",n); //読込みファイル数

max=X+n+1; //読み込み終了条件

for (i=X; i<max; i++){
a=i;
b=""+a;// iは数値のため，いろいろ変数を変えて型変換させた
file1= b+"keV.txt";// ""+ これで iを数値から文字列として定義
path1 = "open="+ dir+file1; //i keV読込みファイル名

run("Text Image... ", path1); //テキストイメージの読込み
run("Fire"); //Image Tableとして fireスタイルを定義
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setMinAndMax(0, 5000); //run("Brightness/Contrast...");の min,max指定
run("Median...", "radius=1");
run("Mean...", "radius=1");

k=i+2;
file2=""+k+"keV.txt"; // ""+ これで kを数値から文字列として定義
path1 = "open="+ dir+file2; //i+2 keV 読込みファイル名
run("Text Image... ", path1); //テキストイメージの読込み
run("Fire"); //Image Tableとして fireスタイルを定義
setMinAndMax(0, 5000); //run("Brightness/Contrast...");の min,max指定
run("Median...", "radius=1");
run("Mean...", "radius=1");

// Diffrential
imageCalculator("Subtract create", file1,file2);
file1="Result of "+ file1;

selectWindow(file1);
//run("Brightness/Contrast...");
run("Fire");
setMinAndMax(-4, 80);

h=i+1;
file_j = dir+h+"keV_d.tif";
saveAs("Tiff", file_j);
print(file_j);
run("Close All");

}
}

//keV-stack.ijm
// keVファイルの差分像の作成
macro "Make stack of diff" {
dir = getDirectory("Choose a Directory"); //directryの選択
V0 = getNumber("Start keV_d.tif, V0=",V0); //最初のファイル
V1 = getNumber("Stop keV_d.tif, V1=",V1); //読込みファイル数

for (i=V0; i<V1+1;i++){
path1 = dir+i+"keV_d.tif"; //読込みファイル名
open(path1); //テキストイメージの読込み
run("Fire"); //Image Tableとして fireスタイルを定義
setMinAndMax(0, 400); //run("Brightness/Contrast...");の min,max指定
}
run("Images to Stack", "name=Stack title=[] use");
}
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